
Teacher’s 
Manual

Book-6
Book-7
Book-8

..... 2

.....22

.....44

0



2

Computer-6

1 	 Computer Languages

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (b)	 2. (c)	 3. (b)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 7	 3. 7	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Language	 2. program	 3. High speed, low memory 
	 4. Programming	 5. 4GLS
D.	 Write answers of the following :
	 1.	� A programming language is a special type of language that 

we can use to give instructions to the computer. 
	 2.	� Machine language is the only language that a computer 

understands. 
	 3.	� Machine Language (First Generation): It is the only language 

that a computer understands. It is expressed in binary form, 
i.e., '0' and '1' where 0 means 'Off' state and 1 means 'On' 
state. 

		�  Assembly Language (Second Generation) : The Assembly 
language is close to the Machine language but in assembly 
language, binary operation codes are replaced by the 
Mnemonics. 

	 4.	� 4GLs are more programmer friendly than earlier generations 
of languages. 
•• 4GLs allow efficient use of databases and data processing. 
•• �4GLs allow a user to add specific system logic to existing 

code. 
•• �4GLs help to produce full systems with options like data 

structures, reports, and even program-specific logic. 
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	 5.	� Interpreter: Translator program is used to convert a high level 
language program into machine language. An Interpreter 
translates line by line, executes the instruction and then 
repeats the procedure for the remaining instructions. 
Interpreter programs are preferred for beginners and are 
slow in execution speed. 

	 	� Compiler: Compiler is a translator program, used to convert 
a high level language program into machine language. A 
Compiler translates the whole program at once, i.e., it 
generates the object code for the program along with the 
list of errors. The execution speed of a compiler is faster as 
compared to an interpreter. 

2 	 Operating System Windows–10

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (d)	 2. (b)	 3. (c)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 7	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1. 2015 	 2. icons	 3. Taskbar 
	 4. bookmarks;	 5. Virtual Desktop 
D.	 Write answers of the following :
	 1.	� It appears at the bottom left corner of the Taskbar. When 

you click this button, a lists of options appears. This list is 
called the Start menu. 

	 2.	� The File Explorer program, previously known as Windows 
Explorer, has been given a noticeable look in Windows 
10. There are plenty of new tools though the basic layout 
and functionality will be familiar to anyone who has used 
Windows XP or later. 
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	 3.	 •	 Open the Settings window from the Start Menu. 
•• �In the settings window, point to your favourite settings 

(Network & Internet) and right-click. 
•• On the small menu that appears, select Pin to Start. 
•• �Click Yes on the screen to confirm the action. After this, 

you will see the Network & Internet app directly in the 
Start Menu. 

	 4.	 • Click the Start button. 
•• �Choose Power, Windows will display options to Sleep, 

Shut down and Restart. 
•• �Select Shut Down to shut down the computer. 

	 5.	� One of the new features of Windows 10 is the addition of 
Virtual Desktops. This allows you to have multiple desktop 
screens where you can keep open windows organised. 

		  To add a virtual desktop, follow these steps: 
•• Click Task View on the Taskbar. 
•• �Click the "New desktop" option on the lower-right corner. 

You can access or delete the new Desktop by clicking Task 
View again. 

3 	 Advanced Features of 

MS Word 2016

A.	 Multiple Choice Question (MCQ) 

	 Darken the correct option in OMR Sheet :

	 1.	 (c)	 2. (b)	 3. (c)	 4. (b)	 5. (c)	 6. (a)
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 3	 3. 7	 4. 7	 5. 7
C.	 Fill in the blanks using help box :
	 1. Insert 	 2. Close 	 3. Mail Merge 
	 4. main document 	 5. Mailings 
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D.	 Write answers of the following :
	 1.	� Headers and footers are parts of a document that contain 

special information such as the document title, company 
logo, any photo, page numbers and the total number of 
pages, etc. 

	 2.	 To insert a Header : 
		  Step 1: Click on the Insert tab. 
		  Step 2 :	� Click on the Header option in the Header & Footer 

group. A gallery of header or footer design appears. 
		  Step 3:	� Select the header design you want. The outline of 

header or footer entry box appears at the top or 
bottom of the page. The Design tab also appears on 
the Ribbon. 

		  Step 4:	� Click on the Placeholders or Content Controls 
and type the desired information to be inserted 
as header. The Content Controls are enclosed in 
square brackets. 

		  Step 5:	� After adding the header, click Close Header and 
Footer option on the Design tab or press the Esc 
key. You will notice that the header and/or footer 
appears at the top and/or bottom of the page. 

	 3.	� Mail Merge feature is used to combine a data source with 
the main document. It saves our time and energy to send 
letters at multiple addresses. 

	 4.	� The three main stages during the mail merge process are 
creating data source, creating main document and merging 
the data source with the main document. 

	 5.	 Step 1:	� To create a new data source, click on Create under 
Type a new list. The New Address List dialog box 
opens. Fill the details of the recipients. The fields 
you do not require can be left blank. 

		  Step 2:	� Click on New Entry to get the blank form for the 
next recipient. 

		  Step 3:	� After typing all the entries, click on OK. 
		  Step 4:	� The Save Address List dialog box appears. Give a 

name to the list and save it. 
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		  Step 5:	� The Mail Merge Recipients dialog box shows the 
data you have entered. You can edit the details in 
it, if required. Then you can move to the next step 
in the Mail Merge Wizard. 

		  Step 6:	� Write your letter is Step 4 of 6. Write the letter in 
the active window. To add recipient information 
in it, click its location in the letter and then click 
on the required options from the Mail Merge task 
pane. The selected fields will appear between '<<' 
and '>>' symbols in the main document. 

		  Step 7:	� Click on Address Block in the Mail Merge task pane. 
The Insert Address Block dialog box appears. Select 
the required options by clicking on the check boxes 
and click on OK. 

		  Step 8:	� Now click on Next: Preview your letters, 5 of 6. This 
will allow you to see the letters one after another 
by clicking on the icon. You can make changes to 
the letters by going back step by step. You can even 
exclude recipients if you want. 

		  Step 9:	� Finally, to merge the document to the data source, 
click on Next: Complete the merge. This is the last 
step. In this step, you have the option to either 
Print the letters or Edit individual letters. 

		  Step 10:	�Give the document a name and save it by clicking 
on the Save As option in the File menu. 

4 	 Enhancing a Presentation

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (c)	 3. (b)	 4. (a)	 5. (d)	 6. (a)
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 7	 3. 3	 4. 3	 5. 3	 6. 7
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C.	 Fill in the blanks using help box :
	 1. Animation effect 	 2. Video Clips 	 3. Play 
	 4. Rehearse timing 	 5. three
D.	 Write answers of the following :
	 1.	� An animation is a visual effect added to the objects on a 

slide (including text, pictures, shapes and so on) or to the 
slide as a whole. 

	 2.	� Slide transitions control how your presentation moves from 
one slide to another. Slide transitions can be very useful 
to enhance your presentations. They grab the audience's 
attention and make a presentation visually appealing. 

	 3.	� Click on the slide to which you want to add an audio clip of 
recorded sound. Make sure a microphone is connected to 
your computer. Follow these steps. 

		  Step 1:	 Click on the Insert tab. 
		  Step 2:	� Click on the down arrow under the Audio option in 

the Media group. 
		  Step 3:	� Click on the Record Audio option. The Record Sound 

dialog box appears. 
		  Step 4:	 Type a name for the audio recording. 
		  Step 5:	 Click the Record button to start recording. 
		  Step 6:	� Click the Stop button when you're finished 

recording. You can click the Play button to listen to 
the recording. 

		  Step 7:	 Click OK. The audio file gets inserted in the slide. 
	 4.	 Video clips can also be added from any CD-ROM. 
		  Step 1:	� Select the Insert tab. Click on the Video drop- down 

list in the Media group and select the Video on My 
PC option. 

		  Step 2:	� The Insert Video dialog box appears on the screen. 
Select the required clip. Click on the Insert option. 

		  Step 3:	� The Format and Playback tabs appear whenever 
you click on the inserted video. You can format the 
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inserted video by clicking on the Format tab and 
selecting various formatting options from it. 

		  Step 4:	� Click on the inserted video clip and select the Play 
button below the video clip. The video will start 
playing. The timeline next to the Play button will 
begin to advance. Click anywhere on the timeline 
to jump to any part of the video. 

	 5.	� Rehearse Timings is a useful feature that helps us to practice 
presenting the slide show. Using this feature, we can save 
the most appropriate timings needed to go through each 
slide and animation in the presentation during a slide 
show. These timings can then be used to run the slide show 
automatically for the audience. 

	 6.	� While designing and running a presentation, the following 
points should be kept in mind: 
•• �Slides should be of a consistent design throughout the 

presentation. 
•• �Use graphics and pictures to make the presentation 

attractive. 
•• Remove unnecessary information and graphics. 
•• Use contrasting background and text colours. 

5 	 Microsoft Excel 2016

A.	 Multiple Choice Question (MCQ) 

	 Darken the correct option in OMR Sheet :
	 1.	 (b)	 2. (a)	 3. (c)	 4. (a)	 5. (b)	 6. (a)
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 7	 3. 7	 4. 7	 5. 7	 6. 3
C.	 Fill in the blanks using help box :
	 1. header 	 2. editing 	 3. Cell 
	 4. Formula Bar 	 5. Auto Fill	 6. Ctrl + X 
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D.	 Write answers of the following :
	 1.	� Worksheet: It is a work area made up of horizontal rows 

and vertical columns wherein you enter and work with data. 
When you open Excel, single worksheet is displayed. You 
can add more worksheets as and when required. An Excel 
worksheet contains 16,384 columns and 1,048,576 rows. 

		�  Workbook: It is a collection of multiple worksheets stored 
under a single file name. When you save an Excel worksheet, 
you are actually saving a workbook. The Excel workbook is 
saved with the extension .xlsx. 

Selection Steps 

2. To select a range of 
adjacent cells 

•• �Click the first cell of 
the range and then 
drag to the last cell to 
highlight all the cells 
in between. 

•• �To select a large range 
of cells, select the 
first cell in the range, 
hold down the Shift 
key and then click the 
last cell of the range. 

To select non-adjacent 
cells or cell ranges 

Select the first cell or cell 
range. Hold down the 
Ctrl key and select the 
second cell or range of 
cells. Repeat these steps 
to select more cells or cell 
ranges if needed. 

	 3.	 Using Drag and Drop Method 
		  Step 1:	� Select a cell or a range of cells. Position the mouse 

pointer at the edge of the selected cells. 
		  Step 2:	� Notice that the pointer changes from a white cross 

symbol to move pointer symbol. 
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		  Step 3:	� Drag the selected cell or a range of cells to a new 
destination, and release the mouse button. The 
data will be moved to a new location. 

	 4.	 The steps to change the contents of a cell completely are : 
		  Step 1:	 Select the cell to be edited. 
		  Step 2:	 Type in the new data into the cell. 
		  Step 3:	� Press the Enter key or the Enter button on the 

Formula Bar to accept the changes. 
	 5.	 The steps to insert a new row are : 
		  Step 1:	� Click on the row heading to select the row above 

which you want to insert the new row. 
		  Step 2:	� Click on the arrow next to the Insert option in the 

Cells group on the Home tab. A drop- down list is 
displayed. 

		  Step 3:	 Click on the Insert Sheet Rows option. 
			�   The selected row is shifted down and a new row is 

inserted at its place. 
	 6.	� Excel provides a wonderful feature for copying cell 

contents. The Auto Fill is the easiest method to fill data in 
cells automatically. 

		  Step 1:	 Type January in cell B1. 
		  Step 2:	� Position the pointer at the lower right corner of the 

cell.  
		  Step 3:	� The mouse pointer changes into a thin black "+" 

cross. 
		  Step 4:	� Hold down the left mouse button and drag the fill 

handle up to cell B5. Release the button. 
		  Step 5:	� The months February to May would appear in the 

cells B2 to B5. 

6 	 Algorithms and Flowcharts

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (b)	 2. (c)	 3. (b)	 4. (b)	 5. (a)	
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B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 3	 3. 7	 4. 3	 5. 7	
C.	 Fill in the blanks using help box :
	 1. looping 	 2. flowchart	 3. two 
	 4. oval 	 5. Flow lines  
D.	 Write answers of the following :
	 1.	� Algorithm is a set of sequential steps to solve any logical 

or a mathematical problem. Algorithm is always written in 
simple language and precise manner so that anyone can 
understand the steps. 

	 2.	� A flowchart is a diagrammatic representations of steps to 
be taken to solve a problem. Program flowcharts shows the 
sequence of instructions in a single program or subroutine. 

	 3.	� Repeating a set of instruction till a specific condition is 
fulfilled is known as looping. 

		  A loop is characterized by two things : 
•• Condition and 
•• Counter whose value is increased or decreased 

		�  Let us consider an example of looping in a flowchart. Consider the 
given flowchart that displays the word 'Programming' five times. 

		�  The value of Count (counter) is initiated to one. It gets 
incremented by one every 
time it displays the word 
'Programming'. The process 
of displaying the word 
and incrementing Count is 
continued as long as value of 
Count is less than or equal to 
5 (condition). This is known as 
a loop. The loop comes to an 
end when the value of Count 
becomes 6. 
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	 4.	� A Decision box is used to test conditions and take decisions. 
A condition can either result in a Yes/No or True/False. A 
Decision box is represented by a diamond shape. 

	 5.	� A Process box is used to show actions or processes such as 
addition and subtraction. A Process box is represented by a 
rectangle. 

7 	 QB64

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (c)	 2. (d)	 3. (c)	 4. (a)	 5. (a)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 7	 3. 7	 4. 3	 5. 7	
C.	 Fill in the blanks using help box :
	 1. program 	 2. constant	
	 3. character set 	 4. numeric value 
D.	 Write answers of the following :
	 1.	� QBASIC which stands for Quick Beginner's All Purpose 

Symbolic Instruction Code. 
	 2.	� A variable is a location in the memory, which has been assigned 

a name, and is used to store data temporarily. It continues to 
hold the value until another value is assigned to it. 

		  There are two types of variables : 
		  1. Numeric Variables,  2. Alphanumeric Or String Variables 
	 3.	� Numeric Constants: Any numeric value, either an integer 

or a real number, positive or negative is called a numeric 
constant. 

		�  Alphanumeric Or String Constants : A set of characters is 
called a String. An alphanumeric or string constant consists 
of a sequence of characters, A-Z, a-z, 0-9 and certain special 
symbols, like % ? # & * ( ) ; : “ /, etc., enclosed in double 
quotes. 



13

	 4.	� When many operators are used in an expression, what 
will be the order of execution? In general, the expression 
is evaluated from left to right, but there are some other 
hierarchy rules that decide the order of calculation. Similar 
to BODMAS rule is applicable in maths, BEDMAS rule is 
applied to QBASIC expressions as follows: 

B Brackets ()
E Exponentiation Λ
D Division /
M Multiplication *
A Additional +
S Subtraction —

	 5.	� It is used to display any message or result on the screen. Any 
text written in double quotes is printed as such. Anything 
written without quotes is treated as a program components 
and its value will be displayed. 

		  Syntax: PRINT "Message" 
		  Print <Variable Name> Example: PRINT 
		  "Welcome to the World of BASIC Programming." 
		�  It will display the message, Welcome to the World of BASIC 

Programming. 
		  PRINT A 
		  It will display the value stored in the variable A. 
		  PRINT 
		  It will leave a blank line. 

8 	 Introduction to Flash CS6

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (b)	 2. (c)	 3. (a)	 4. (b)	 5. (c)	
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B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 3	 3. 3	 4. 7	 5. 3	
C.	 Fill in the blanks using help box :
	 1. New 	 2. Tools Panel	 3. polygon, Star 
	 4. Brush	 5. Lasso	  
D.	 Write answers of the following :
	 1.	� Animation is the technique of creating an illusion of 

movement by rapidly displaying a sequence of still images 
(with slightly varying positions/postures). 

	 2.	� Adobe Flash is a popular animation software used for 
creating animations, games and even full length animation 
movies complete with sound and special effects. Flash is 
specially suitable for creating animations for websites since 
the size of a flash movie is very small which makes them 
easy to upload and download. 

	 3.	 To create a new document, follow these steps: 
		  Step 1	:	 Click on File and then New. 
		  Step 2	:	 New Document dialog box appears. 
		  Step 3	:	� The New Document dialog box displays the file 

types you can create in Flash Professional. 
		  Step 4	:	� Click on the ActionScript 3.0 file type, if it is not 

already selected. 
		  Step 5	:	 Click on OK. 
		  Step 6	:	� The Adobe Flash new document window appears 

on the screen. 
		�  Now you are ready to work with the master document, 

which uses the file extension .fla and thus called FLA file. 
	 4.	� The Paint Bucket tool fills enclosed areas with colour. It can 

fill empty areas and change the colour of already painted 
areas. 

		  Step 1	:	 Select the Paint Bucket tool. 
		  Step 2	:	 Choose a fill colour from the color tool box. 
		  Step 3	:	� Click the shape or enclosed area that you want to fill. 
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	 5.	� The Line Tool works exactly the same way as the Line tool in 
graphics software. 

		�  The Pencil tool allows us to draw freehand lines just as we 
draw using a real pencil. 

9 	 Internet Services

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (c)	 2. (c)	 3. (b)	 4. (a)	 5. (b)	 6. (d)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 3	 3. 3	 4. 7	 5. 3	
C.	 Fill in the blanks using help box :
	 1. 1969 	 2. e-mail	 3. modem
	 4. web browser	 5. compose	  
D.	 Write answers of the following :
	 1.	� The World Wide Web (WWW or W3) is a system of interlinked 

hypertext documents accessed via the Internet. With a web 
browser, one can view web pages that may contain text, 
images, videos and other multimedia and navigate between 
them via hyperlinks. 

	 2.	� Social networking is possible in person, especially in the 
workplace, universities, etc. This is because most high 
schools, colleges or workplaces, the internet is filled with 
millions of individuals who are looking to meet other people, 
to gather and share share first-hand information. 

	 3.	� The first thing we need to connect to the Internet is a 
computer. Other than the computer, we also need a few 
more things. 

		  1. Modem,	 2. Telephone Line,	 3. ISDN Line, 
		  4. Internet Service Provider (ISP), 	 5. Web Browser 
	 4.	� E-Mail stands for Electronic Mail. It is a facility on Internet to 

compose, store, send, and receive messages to any part of the 
world. The convenience, simplicity, and affordability of sending 
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mails on Internet has totally changed the correspondence 
system. 

	 5.	 To attach a file to an e-mail, follow these steps : 
		  Step 1	:	� Click on the Attach a file icon on the toolbar at the 

bottom of the Compose window. 
		  Step 2	:	� The Open dialog box will appear. 
		  Step 3	:	� Browse through your files, and select the file you 

would like to attach. 
		  Step 4	:	� Click on the Open button. The file gets attached to 

your mail. Now click on the Send button. 
	 6.	� A signature is a bit of personalised text (such as contact 

information or a favourite quote) that is automatically 
inserted at the bottom of every e-mail you send. To create a 
signature, follow these steps :

		  Step 1	:	� Click on the gear icon in the upper right, then select 
the Settings option.

		  Step 2	:	� Enter your new signature text in the box at the 
bottom of the page next to the Signature option.

		  Step 3	:	 Click on the Save Changes tab.

10 	 Introduction to Python

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (a)	 3. (b)	 4. (b)		
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 3	 3. 7	 4. 3	 5. 7	
C.	 Fill in the blanks using help box :
	 1. interpreter 	 2. interactive	 3. Function
	 4. F5	 5. Keywords	  
D.	 Write answers of the following :
	 1.	� IDLE works in two modes-interactive and script. 
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•• �The interactive mode– is useful for running a single line 
of code. It displays the results automatically.
•• �The script mode lets you work with more than one line 

of code. You can save the file or script and run the code.
	 2.	� In computer programming, data types are used to store 

different types of data. A particular data type defines the 
type of operations that can be performed on the data.

		�  Following are the built-in data types of Python with 
examples.

Date type Description Example

Number It stores numeric values 
as well as floating-point 
(decimal) values.

45, 82.5, 282727

String It stores a combination 
of letters within the 
quotation (“ ”) marks.

“Mike”, “School”, “hello”

List it contains items 
separated by a comma.

[1, 2, 3, 4], [ 2, “kc”, 86.5]

Dictionary It contains keys with 
their corresponding 
values.

{‘A’ : 1, ‘B’ : 2 }

Tuple It is similar to lists. The 
only difference is that 
it cannot be modified 
and is enclosed by 
parentheses ().

(1, 2, 3, 4)

	 3.	� An identifier is a name given to a programming element. It 
helps in identifying individual elements.
•• �An identifier can be any combination of lowercase letters 

(a-z), uppercase letters (A-Z), digits (0-9),and underscores 
(_). For example, myVar, kc93, and hello_world are all 
valid identifiers.
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•• �An identifier name can start with an underscore, For 
example, _john, _myClass1, and _ket876 are all valid 
identifiers.
•• �An identifier cannot begin with a digit. For example, 1var 

cannot be an identifier, but var1 is a valid identifier.
•• Keywords cannot be used as identifiers.
•• �Special symbols (except underscore), such as $, #, and @, 

cannot be used in identifiers. For example, ket@js is an 
invalid identifier.
•• An identifier name cannot contain any space.
•• Identifier names are case-sensitive.
•• Identifiers can be of any length.

	 4.	� Assigning a Value to a Variable : To assign a value to a 
variable, the assignment operator (=) is used. The general 
syntax for assigning a value to a variable is as follows :

		  variable_name=value
		  For example : 
		�  To store an integer value 10 to a variable named 'var', the 

statement will be as follows:
		  var=10
		  Some more examples are :
		  name=“Rashmi” (�Assigning a string value to the variable 

named 'name')
		  age=15.12	 	 (�Assigning a float-value, that is a decimal 

value, to the variable named 'age')
	 5.	� An operator is a symbol that represents an action, such as +, 

-, x, and÷.An operand is a number on which an operator acts.
		  The types of operators in the programming languages are :

•• Arithmetic used for arithmetic calculations.
•• Comparison used for comparing values.
•• Logical used in logical calculations.
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	 	 Arithmetic Operators
		�  Listed below are some common arithmetic operators with 

the operations they perform.

Operator Operation Example

+ Addition 6 + 7 = 13

– Subtraction 8 – 5 = 3

* Multiplication 4 * 5 = 20

/ Division 20/4 = 5

% Modulus 13%2 = 1

		�  Comparison Operators : Listed below are the comparison 
operators used in programming languages. These operators 
are also called relational operators. 

Operator Operation Example Result

> Greater than 5 > 3 True

< Less than 3 < 7 True

!= Not equal to 4 ! = 4 False

= = Is equal to 5 = = 6 False

>= Greater than equal 5 > = 5 True

< = Less than equal 4 < = 6 False

		�  Logical Operators : A logical operator is used to combine two 
or more expressions and there are three logical operators' 
and, or and not. 

Operator Description
Example 
(A=5, B=10)

Result

and
If both the values are true, 
the result is true.

A > B and A = B False
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or
If any of the two values is 
true, the result becomes 
true.

A < B or A > B True

not
If an expression A is true 
then not A will be false and 
vice versa.

not A True

11 	 Artificial Intelligence

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (a)	 3. (b)	 4. (b)	 5. (d)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 3	 3. 7	 4. 3	 5. 3
C.	 Fill in the blanks using help box :
	 1. Visual perception, Speech recognition, Language translation 	
	 2. John McCartly	 3. Kinect, Xbox 360  4. Apple
	 5. Knowledge representation    6. Machine learning 	  
D.	 Write answers of the following :
	 1.	� Google Home, a smart speaker: Google released Google 

Home in 2016. It uses AI to act as a personal assistant 
helping the user by reminding tasks, creating appointments, 
and searching information by voice.

	 2.	� Spirit and Opportunity
	 3.	� ASIMO
	 4.	� Artificial Intelligence or AI refers to software technologies 

that give machines or robots the intelligence to perform tasks 
generally performed by intelligent beings. It is the ability of 
a robot or a machine to do tasks that usually require human 
intelligence. Speech recognition, decision-making, language 
translation, and visual perception are some examples of 
human intelligence that artificial intelligence may posses.
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	 5.	� In 1970s : The 1970s saw an expansion of the computer 
era with the development of much quicker and affordable 
machines, with higher storage capacity. Their characteristics 
include abstract thinking, self-recognition, and could 
accomplish natural language processing.

		   �The development of the intelligent robot WABOT (Waseda 
robot) possessing human-like characteristics began in Japan 
at Waseda University.

	 6.	� Rule Based Approach : A rule-based system uses rules as 
knowledge representation. These rules are coded in the 
system in the form of if-then-else statements which help 
the computer in taking decisions. The idea behind a rule-
based system is to use the knowledge of a human expert in 
a specialised domain and embody it within the computer 
system.
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Computer-7

1 	 Number System

A.	 Multiple Choice Question (MCQ) 

	 Darken the correct option in OMR Sheet :

	 1.	 (c)	 2. (c)	 3. (b)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 3	 3. 7	 4. 7	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 Decimal	 2. 0 and 1	 3. bit	
	 4.	 Subtraction 	 5. eight	
D.	 Write answers of the following :
	 1.	� To convert decimal number into a binary number,  follow 

the given rules: 
•• Divide the given decimal number with the base 2. 
•• �Write down the remainder and divide the quotient again 

by 2. 
•• Repeat the step 2 till the quotient is zero. 

	 2.	� Binary number system, is used by computers because a 
computer can understand only two states, i.e. presence and 
absence of the electrical pulse.

	 3.	� A binary digit, is called a bit. A series of eight bits makes a 
byte. 	

	 4.	� Binary Addition : The technique used to add binary 
numbers inside the computer is very easy and simple. This 
is performed in the same way as we perform addition with 
decimal numbers.

		�  The following table illustrates the addition of two binary 
digits :  	
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a b a + b = c
0 0 0 + 0  = 0
0 0 0 + 1 = 1
1 0 1 + 0 = 1  
1 1 1 + 1 = 0 with 1 carry

		�  Binary Subtraction : The rules given in the table must be 
followed to perform binary subtraction. 

a b a – b = c
0 0 0 – 0  = 0
0 0 0 – 1 = 1 (with borrow)
1 0 1 – 0 = 1  
1 1 1 – 1 = 0 

	 5.	 The base of the following Number System: 
		  Number System 	 Base 
		  Decimal 		  10 
		  Binary 		  2 
		  Octal 		  8 
		  Hexadecimal	 16 

2 	 Formulas and Functions 

in Excel

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (d)	 2. (c)	 3. (b)	 4. (b)	

B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 3	 3. 3	 4. 7	 5. 7

C.	 Fill in the blanks using help box :
	 1.	 absolute	 2. formula	 3. equals	

	 4.	 left right 	 5. Dollar sign	
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D.	 Write answers of the following :
	 1.	� A text string or a text value is a sequence of characters on 

which you cannot perform mathematical operations like 
addition, subtraction, multiplication, or division. However, 
you can join strings. Joining the strings is called concatenation. 

	 2.	� Formulas are equations that perform calculations on values 
in your worksheet. You can make your own equation to 
perform certain calculation, e.g. 5 + 2 * 3. This formula 
multiplies 2 by 3 and then adds 5 to the result. To make it 
different from number entry we start typing a formula with 
an equal sign (=). For example: = 5 + 2 * 3 

	 3.	� A reference identifies a cell or a range of cells in a worksheet, 
and tells Excel where to look for the values or data you want 
to use in a formula. A range of cells is referenced using a 
colon. 

		�  A relative cell reference in a formula is based on the relative 
position of the cell that contains the formula, and the 
referenced cell. 

		�  Absolute Reference: We put a $ sign before the column 
letter and before the row number to make the reference 
absolute. An absolute cell reference in a formula, such as 
$A$1, always refer to a cell in a specific location. 

		�  Mixed Reference : A mixed reference has either an absolute 
column and relative row, or absolute row and relative 
column. We put a $ sign before the column letter or before 
the row number, whatever we want to make absolute. 

	 4.	� In Excel, functions are defined as built-in formulas that are 
used to perform calculations or to return information about 
your spreadsheet data. 

		  (a) AutoSum 	 (b) Average ()
		  (c) Max () and Min ( ) 	 (d) Count() 
	 5.	 •  �Operations are carried out in the order in which they 

occur in the formula, which is left to right. 
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•• �Any operation contained in brackets will be carried out 
first, followed by any exponent (power). 
•• �Then follow division and multiplication operations, which 

are given equal importance. Whichever operator appears 
first in the formula is carried out first. 
•• �After that, addition and subtraction operations are given 

equal importance.  

3 	 Creating Charts in MS Excel

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (b)	 2. (a)	 3. (c)	 4. (b)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 3	 3. 3	 4. 7	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 Plot Area	 2. Category	 3. Pie	
	 4.	 Column 	 5. Doughnut	
D.	 Write answers of the following :
	 1.	� Gridlines, Chart Area, Plot Area, Data Table. 
	 2.	 Step 1	: �Select the range of cells B3:E6 that contains the 

data. 

		
		  Step 2	: �Select the Insert tab. 
		  Step 3	: �Click on the Line option under the Sparklines group. 
		  Step 4	:	 The Create Sparklines dialogue box will open. 
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		  Step 5	: �As the Data 
Range is already 
selected, select 
the Location 
Range where 
the sparklines 
are displayed. 
Select the cells 
F3:F6. 

		  Step 6	:	� The sparklines 
will be 
included in the 
sheet as shown 
in figure. 

		  Step 7	:	� You can use 
the Design 
tab options 
for sparklines 
to highlight 
specific points 
by selecting the respective check boxes. 

	 3.	� A legend indicates the nature of data displayed in a chart. 
For example, if two data series are displayed in a chart, the 
legend shows what each series contains. To add Legend, 
choose the Legend option from the Add Chart Element 
drop-down list and choose the appropriate option to display 
a legend for a chart from the submenu. 

	 4.	� Pie Chart: Pie charts are used when we want to show the 
relationship of different parts of data to the whole data. 

		�  Doughnut Chart: A doughnut chart is similar to a pie chart 
except that it can display more than one data series. A pie 
chart can display only one data series. 

	 5.	� Gridlines are used for vertical and horizontal lines that make 
it easier to read a chart. 
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4 	 More on Flash

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (b)	 2. (d)	 3. (b)	 4. (a)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 3	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :

	 1.	 Frame	 2. symbols	 3. File	 4. Keyframe 	
D.	 Write answers of the following :

	 1.	� The steps to convert an existing drawing into a symbol are : 
		  Step 1	:	 Select the Selection (Arrow) Tool. 
		  Step 2	:	� Draw a selection area around the object on the 

Stage to select it. 
		  Step 3	:	� Select Modify > Convert to Symbol. The Convert to 

Symbol dialog box appears. 
		  Step 4	:	 Type a Name for the symbol. 
		  Step 5	:	� Select the type of symbol from the options Movie 

clip, Button, or Graphic. Here, we have selected 
Graphic. 

		  Step 6	:	� Click OK. The symbol now gets added to the Library 
panel. 

	 2.	� To rotate the selected object, position the pointer over one 
of the four corner handles. 

		�  When the pointer changes to a curved arrow, click and drag 
to rotate the object. 

	 3.	 Inserting a Frame or a Keyframe 
		  The steps to insert a frame or keyframe are : 
		  Step 1	:	� On the Timeline, click on a rectangular placeholder 

where you want to insert a frame or a keyframe. 
		  Step 2	:	 Select Insert > Timeline > Frame. 
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Or 
				    Select Insert > Timeline > Keyframe. 
	 4.	� In motion tweening, you specify the beginning and end 

position of an object and Flash automatically fills the frame 
in between. Usually, motion tweening works on symbols or 
groups of objects. 

	 5.	� Layers are like transparent sheets of paper. You can draw 
different objects on each layer and make it appear on the 
stage whenever you want. Imagine that each image is a 
separate layer that has been drawn. They are placed on 
top of each other to create the illusion that everything was 
drawn on one sheet, but they are on separate layers. 

5 	 Control Statements in QBasic

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (c)	 3. (c)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 3	 3. 7	 4. 3	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 Else instructions	 2. statements	 3. False
	 4. True 	 5. Exit 	
D.	 Write answers of the following :

	 1.	� Conditional statements are used to execute a block of 
statements depending upon a condition. They help to 
control the flow of the program and hence are also known 
as control statements. 

	 2.	� The IF...THEN statement is the most basic conditional 
statement and it is used to check conditions. If the condition 
is true then the statements written between IF...THEN and 
END IF are executed. 
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		�  For example, the following program prompts the user to 
enter age. It displays the message "You are allowed to vote" 
if the age is more than or equal to 18. 

		  REM A program to check the age for voting 

		  CLS 

		  PRINT "Enter your age:" 

		  INPUT Age 

		  IF Age >= 18 THEN 

		  PRINT "You are allowed to Vote" 

		  END IF 

	 3.	� A nested loop is a loop within a loop, an inner loop within 
the body of an outer loop. When the outer loop executes 
once, the inner loop executes to completion. 

	 4.	� Do While Loop: This loop is executed as long as the specified 
condition is true. The Do While loop first executes the block 
of statements then checks the conditions. 

		  Syntax: 
		  DO 
		  { 
		  Statement(s) 
		  }
		  LOOP WHILE Condition 
		�  Do Until Loop: This loop is similar to the Do While loop, 

but the only difference is that the execution of the loop 
continues as long as the condition is false. Syntax: DO UNTIL 
Condition 

		  { 
		  Statement(s) 
		  } 
		  LOOP 
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	 5.	� To end a loop prematurely, use the EXIT command, followed 
by either FOR or DO. Here is an example : 

		  FOR X = 5 TO 10 
		  PRINT X; 
		  IF (X = 8) THEN EXIT FOR 
		  NEXT X 
		  The output of this program will be 5 6 7 8  

6 	 Introduction to HTML

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (c)	 2. (c)	 3. (b)	 4. (b)	 5. (d)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 7	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 HTML	 2. attribute	 3. title
	 4. two	 5. web browser 	
D.	 Write answers of the following :
	 1.	� HTML is a language used for designing webpages. It is a 

language that describes the content, format and layout in 
which a webpage should be displayed over the World Wide 
Web.

	 2.	� There are two types of HTML editors : WYSIWYG editors and 
text editors.

	 3.	  <HTML>
•• <Title>

•• <Body>
•• <Head>

	 4.	� The first thing you should notice about these HTML tags, 
is that all tags include less than (<) and greater than (>) 
symbols on either side of the tags command. This is how 
HTML recognises tags. There are three types of tags: 

		  (a) Container Tags	 (b) Empty Tags	 (c) Comment Tags 
	 5.	� An attribute is a special keyword used inside the tag to specify 

additional information about the tag and customise it. 
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		  For example, <H1 align = "center"> 
		�  In this example, 'align' is an attribute of <H1>. It indicated that 

the text inside the <H1> tag is to be displayed in the center. 
		�  Most attributes are optional and are only used when the 

default behaviour of a tag is to be changed. 

7 	 Basic Tags in HTML

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (c)	 2. (b)	 3. (b)	 4. (b)	 5. (b)	 6. (b)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 7	 3. 3	 4. 3	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Bgcolor	 2. No shade	 3. face
	 4. <I>	 5. <P> 	
D.	 Write answers of the following :

	

1.

	

Attribute Description Example
Bgcolor This attribute is used to  

specify the background   
colour of the webpage. 
If you do not use the 
bgcolor attribute then 
the default background  
white. 

<BODY 
bgcolor="green">

Text This attribute is used to 
specify the color of the 
text to be displayed on 
the web page. 
If you do not use the 
text attribute then the 
default colour of the 
text is black. 

<Body text 
specify the colour 
of the "red"> 
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	 2.	� The <br> tag is an empty tag, which means it does not have 
a closing tag. It is used to start a new line. 

		�  To display a long piece of text on a web browser, paragraph 
element <P> is used, which makes a block of text as a 
paragraph. 

	 3.

Attribute Description Example
Size Numbers 

in Pixels
It is possible to set 
the relative size of the 
text by setting the size 
attribute of the <font> 
tag.

<font size = 
"7" > text </
font>     

There are seven relative 
sizes for text, numbered 
from 1 to 7, where 1 is 
the smallest and 7 is the 
largest. The default size 
is 3.

Face Font 
name

The face attribute of 
the <font> tag is used 
to specify the type of 
font to be applied to the 
text enclosed between 
<font> and </font tags> .

<font face = 
"Times New 
Roman"> 
text </font>

Color Color 
name

The color attribute of 
the <font> is used to 
specify the text enclosed 
between <font> and </
font> tags.

<font color 
= "green"> 
text </font>

	 4.	� These tags are used to define different heading levels in an 
HTML document. These are basically used to emphasize the 
text. There are six heading levels, H1 to H6. The H1 heading 
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style displays the text in the largest size and is mainly used for 
main headings. The lower levels are used for sub headings 
and less important things. It is not essential to use these 
heading levels in hierarchy. These heading tags are written 
within the <BODY> tag of the document. 

	

5.

	
�

Attribute Description Example
Noshade Noshade To specify 

that the horizontal line 
should appear as a solid 
stripe accross the page, 
rather than a shaded 
stripe. 

<HR noshade> 

8 	 Introduction to Photoshop CS6

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (c)	 3. (d)	 4. (a)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 3	 2. 7	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 image editing	 2. .psd	
	 3. document window	 4. Tool Panel 	 5. Move	
D.	 Write answers of the following :
	 1.	� Adobe Photoshop is a powerful application for almost any 

kind of image editing and creating high-quality graphics. 
Photoshop has so many features that it used professionally 
to edit photos or graphics. 

	 2.	� It is used to select an image or part of it in a rectangular, 
square, elliptical or circular shape. 

		  Step 1	:	� Click on the Rectangular Marquee Tool in the Tools 
palette. The cursor appears as a cross- hair sign. 
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		  Step 2	:	� Place the cursor on 
the image. Click and 
hold the left mouse 
button and then 
drag out a marquee to select the required part of 
the picture. 

		  Step 3	:	� We will notice that a dashed border has covered 
the object, which we have selected as shown in the 
figure. 

		  Step 4	:	� Press the Delete Key on the keyboard. A Fill dialog 
box appears. 

		  Step 5	:	� Select Background color in the Use field and click 
OK. We will notice that the selected part of the 
image will be deleted. 

	 3.	� The Marquee Tool is used to select an image or part of it in 
a rectangular, square, elliptical or circular shape. 

		�  The Lasso tools are used to make free-hand selections in an 
image. 

	 4.	� Panels help you to monitor and modify your work. For 
example, the Layers panel and Color panel which provides 
context-sensitive tools to make quick updates. 

	 5.	 Copying a Part of an Image:  
		�  The Move tool allows us to quickly create a copy of our 

selection. 
		  Step 1	:	 Select a part of an image using any selection tool. 
		  Step 2	:	 Click on the Move tool. 
		  Step 3	:	� Hold the ALT key and click and drag selection to a 

different location. We will see that a copy is created 
for us and moved to a new location.  
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9 	 Computer Virus

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (d)	 2. (b)	 3. (a)	 4. (d)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 7	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 malicious code	 2. spread, replicate	 3. Viruses	
	 4. backdoor 	 5. pirated	
D.	 Write answers of the following :
	 1.	� A virus is a small infectious agent that replicates only inside 

the living cells of other organisms. A computer virus is a 
program or piece of code that is loaded onto your computer 
without your knowledge and runs against your wishes. 

	 2.	� Viruses can be classified by their infection targets into the 
following types: 

		  1. Boot Viruses, 2. Program Viruses, 3. Macro Viruses 
	 	� Boot Viruses: These viruses infect the boot record or master 

boot record. They replace the boot record that is responsible 
for loading the Operating System in the computer memory 
by copying it elsewhere. Boot virus becomes active at the 
time of booting the machine. Examples are Disk Killer, 
Stoned Virus, etc. 

		�  Program Viruses: These viruses infect executable files, 
programs, such as those with extension, like .com, .exe, .ovl, 
.drv, .sys, etc. These programs get loaded in the computer 
memory during execution. The virus becomes active in the 
computer memory by replicating itself and infecting files on 
the disk. Examples are Sunday, Cascade, etc. 

	 3.	� The proper knowledge of viruses can keep your computer 
protected from the malicious attack of the viruses. 
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		�  The following are the main causes of a computer virus : 
Infected Flash Drives Disks: Flash drives and disks are the 
main cause of spreading viruses. 

	 	� Email Attachments: Many viruses spread through emails. 
An email may contain an infected file attachment. 

		  �Infected Websites: There are many insecure websites those 
can infect computer with viruses. 

	 	� Networks: Virus can spread if an infected computer is 
connected to a network. The internet is an example of such 
network. 

	 	� Pirated Software: An illegal copy of software is called 
pirated software. A variety of pirated software is available in 
CDs and many are available to download from the internet. 

	 4.	  �Take backup of your data regularly. An important way 
of precaution against virus is the use of backup of data. 
The backup is used if the virus deletes original data or 
modifies it. 
•• �Freeware and shareware software from the internet 

normally contain viruses. It is important to check the 
software before using them. 
•• �Your best protection is your common sense. Never click 

on suspicious links, never download songs, videos or files 
from suspicious websites. Never share your personal data 
with people you don't know over the internet. 

	 5.	� A computer system can be protected from virus by following 
these precautions:  
•• �Antivirus software and firewall should be installed on the 

computer. 
•• The antivirus software must be upgraded regularly. 
•• �USB drives should be scanned for viruses, and should not 

be used on infected computers. 
•• �Unknown emails should not be opened and must be 

deleted straight away. 
•• �Unauthorised or pirated software should not be installed 

on the computer.  
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10 	 Tokens in Python

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (d)	 3. (a)	 4. (a)	
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 3	 3. 7	 4. 3	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 python	 2. open source	 3. Logical Operators	
	 4. Punctuators 	 5. reserved words	 6. Arithmatical operations	
D.	 Write answers of the following :
	 1.	� Features of Python Programming : Python is a simple and 

powerful language.
		  Following are the features of python:
		�  Open Source: Python is an open-source language and can 

be easily downloaded from the Internet for free.
		�  Portable: Programs written in Python can run on almost every 

known platform such as Windows, Linux and Macintosh.
		�  Libraries and Tools: Programming in Python is easier because 

the libraries and supporting tools make even a complicated 
task easy.

		�  Dynamic Memory Allocation: When an object is created in 
Python, memory is dynamically allocated to it. This memory 
is also retracted when it is no longer being used.

	 	� Object-Oriented: Python has an object-oriented approach. 
This means that the programs are designed using objects 
and classes that interact with each other.

		�  Easy to understand: The syntax or grammar of Python is 
simpler, hence making it easier to learn and understand. 
Writing programs in Python is easy as compared to other 
high-level programming languages.

		�  Interpreted: It is an interpreted language that executes code 
line by line at a time which makes debugging hassle-free.
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		�  Integrated and Extensible language: We can easily integrate 
Python with other languages such as C, C++. We can also 
write and compile a Python code in C or C++. 

	 2.	� A set of valid characters recognised by a language is called 
a character set. The characters are used in Python source 
program belong to Unicode standard. The characters in 
Python are grouped into the following categories:
•• Alphabet: A to Z (uppercase), a to z (lowercase)
•• Digits: 0 to 9
•• �Special characters (:) colon space ( ) + _ – * //\ ^ & % #$ {} 

[] ! _(underscore) >< ? @ , ; : etc. (white space, blank space, 
horizontal tab (→), carriage return, New line, form feed)

		�  Python can process any of the ASCII and Unicode characters 
as data or as literals. 

	 3.	� An identifier is a sequence of characters taken from Python 
character set. It refers to variables, functions and arrays.

	 4.	� Assignment Operators : These operators are used to assign 
value to a variable.

Operator Name Description Example
 (x=2)

= Assignment It assigns the value of the 
operand on the right side 
to the left side operand.

x = 5

+= Addition 
assignment

It adds the right operand 
to the left operand and 
assigns the result to 
left operand. x+=3 is 
equivalent to x=x+3.

x += 3

–= Subtraction 
assignment

It subtracts the right 
operand from the left 
operand and assigns the 
result to left operand. 
x–=3 is equivalent to x=x 
– 3.

x –= 3
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*= Multiplication 
assignment

It multiplies the right 
operand with the left 
operand and assigns the 
result to left operand. 
x*=3 is equivalent to 
x=x*3.

x *= 3

/= Division 
assignment

It divides the left operand 
with the right operand 
and assigns the result 
to left operand. x/=3 is 
equivalent to x=x/3.

x /= 3

%= Remainder 
assignment

It takes the modulus 
of two operands and 
assigns the result to 
left operand. x%=3 is 
equivalent to x=x%3.

x %= 3

//= Floor division 
assignment

It performs floor division 
on operators and 
assigns the value to the 
left operand. x//=3 is 
equivalent to x=x//3.

x //= 3

**= Exponentiation 
assignment

It performs exponential 
(power) calculation on 
operators and assigns the 
value to the left operand. 
x**=3 is equivalent to 
x=x**3.

x **= 3

	 5.	 Some commonly used keywords in Python are given below:

false assert del for in or while

none break elif from is pass with



40

true class else global lambda raise yield

and continue except if nonlocal return async

as def finally import not try await

	 6.	 To run a Python program, follow the steps given below:
		  Step 1	:	 Click on the Run menu.
		  Step 2	:	 Click on the Run Module option.

		

		  The output will be displayed in the Python Shell window. 

		

11 	 Artificial Intelligence (AI) 
and its Approaches

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (c)	 2. (c)	 3. (a)	 4. (b)	
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B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 7	 3. 3	 4. 3	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Artificial intelligence	 2. Storage Artificial Intelligence	
	 3. Narrow AI		  4. Agent function		
	 5. Architecture		  6. Self-aware	
D.	 Write answers of the following :
	 1.	� Artificial Intelligence (AI) is the simulation of human 

intelligence process by machines, especially computer 
systems. AI imparts intelligence to the machines so that the 
intelligent machines can work, operate, and react just like 
human beings and help in decision-making based on real-
time scenarios. Artificial Intelligence is a technology that 
uses smart software tools to provide semantic intelligence 
to devices and machines just like humans do. The software 
understands the business scenario, analyses real-time 
data, makes decisions, performs tasks, and gives responses 
accordingly.

	 2.	� Artificial General Intelligence (AGI) : This is a type of artificial 
intelligence which can perform any task that involves 
intelligence like humans. The devices built on the concept 
of Artificial General Intelligence are intended to imitate 
thinking and decision-making abilities of a human mind. 
They focus mainly on highly intellectual tasks rather than 
emphasizing on the fundamental chores. Artificial General 
Intelligence is also known as strong artificial intelligence.

		�  For example, Hanson Robotics, A Hong Kong based 
engineering and robotics company, has developed a social 
robot called Sophia that has an ability to learn from its 
surroundings and make appropriate decisions.

	 3.	� The task of AI is to design an agent program which implements 
the agent function. The structure of an intelligent agent is a 
combination of architecture and agent program. It can be 
viewed as:

Agent = Architecture + Agent Program
		�  Following are the main three terms involved in the structure 

of an AI agent:
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		�  Architecture: Architecture is machinery that an AI agent 
executes on.

		�  Agent Function: Agent function is used to map a sequence 
of perceptions into an action.

		�  Agent program: Agent program is an implementation of 
agent function. An agent program executes on the physical 
architecture to produce function. 

	 4.	� PEAS is a representation system for AI agents which caters 
to measuring performance with respect to Environment, 
Sensors, and actuators. To design an agent, we must know 
our task environment. PEAS system helps specify the task 
environment. It is made up of four words:

		  P : Performance measure	 E : Environment
		  A : Actuators	 S : Sensors
		�  Here performance measure is the objective for the success 

of an agent’s behaviour.

		�  PEAS for self-driving cars : The representation of PEAS for 
self-driving cars will be:

		  Performance	 :	 Safety, time, legal drive, comfort
		  Environment	 :	� Roads, other vehicles, road signs, pedestrian
		  Actuators	 :	 Steering, accelerator, brake, signal, horn
		  Sensors	 :	� Camera, GPS, speedometer, odometer, 

accelerometer, sonar.
	 5.	 �Artificial General Intelligence (AGI) : This is a type of artificial 

intelligence which can perform any task that involves 
intelligence like humans. The devices built on the concept 
of Artificial General Intelligence are intended to imitate 
thinking and decision-making abilities of a human mind. 
They focus mainly on highly intellectual tasks rather than 
emphasizing on the fundamental chores. Artificial General 
Intelligence is also known as strong artificial intelligence.

		�  For example, Hanson Robotics, A Hong Kong based 
engineering and robotics company, has developed a social 
robot called Sophia that has an ability to learn from its 
surroundings and make appropriate decisions. 
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		�  Artificial Super Intelligence (ASI) : Super AI is a level of 
intelligence of systems at which machines could surpass 
human intelligence, and can perform any task better than 
human with cognitive properties. It is an outcome of general 
AI. Some key characteristics of strong AI include the ability 
to think, to reason, solve the puzzle, make judgments, plan, 
learn and communicate by its own. 

	 6.	� Reactive Machines : These machines are the most basic form 
of AI applications. Examples of reactive machines are games 
like Deep Blue, IBM’s chess-playing supercomputer. The AI 
teams do not use any training sets to feed the machines, nor 
do the later store data for future references. Based on the 
move made by the opponent, the machine decides/predicts 
the next move.  

	 7.	� Theory of Mind : Theory of mind is the concept where 
the bots will be able to understand the human emotions, 
thoughts, and how they react to them. If the AI-powered 
machines are ever to mingle with us and move around with 
us, understanding human behaviour is imperative. And then, 
reacting to such behaviours accordingly is the requirement. 

E.	 Write the full form of the following :
	 1.	 AGI	 Artificial General Intelligence
	 2.	 ASI	 Artificial Super Intelligence
	 3.	 ANI	 Artificial Narrow Intelligence
	 4.	 PEAS	 Performance Environment Actuators Sensors
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Computer-8

1 	 Networking Concepts

A.	 Multiple Choice Question (MCQ) 

	 Darken the correct option in OMR Sheet :

	 1.	 (b)	 2. (c)	 3. (c)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 3	 3. 7	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Hub	 2. Router	 3. Internet	
	 4.	 Star 	 5. Coaxial Cable	
D.	 Write answers of the following :
	 1.	� In general, Networking refers to creating networks. A 

network is a group of devices linked to each other. A cable 
network and a telephone network are examples of networks. 

		�  Easy data sharing : Computer networking has made it easy 
to share useful information instantly. 

		�  Easy access to data : Data stored on a local storage device 
may be lost if the device gets corrupted and no backup has 
been made. 

		�  Cost-effectiveness : Using a computer network allows us 
to share hardware devices, such as printers, modems, and 
scanners, which reduces the overall cost of the hardware. 

		�  No need to keep hard copies of documents : In a computer 
network, we share soft copies of documents, which has 
reduced the need for keeping hard copies of documents. 

	 2.	� Router : A router is a communication device that is used to 
connect two different networks, such as two LANs or a LAN 
and a WAN. It plays a vital role in controlling the traffic and 
keeping the network efficient. It chooses the best route for 
the data packets to be transmitted at the receiver's end. 
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		�  Switch: A switch is a device that is also used to connect 
computers in a network. However, a switch is a more 
intelligent device than a hub. Unlike a hub, the switch sends 
the incoming data to the desired destination only. It records 
the addresses of all the computers connected to it. 

	 3.	� A PAN is a network of personal devices equipped to 
handle networking within a limited area. It handles the 
interconnection of IT devices within the surroundings of a 
single user. 

		�  A LAN is the basic building block of any computer network. 
A LAN can range from two computers connected by a cable 
to hundreds of connected computers and peripherals in a 
big corporation. 

	 4.	� The term 'network topology' refers to the way in which 
different devices are arranged physically or logically in a 
network. A physical topology is a physical arrangement 
of different nodes (connection points within a network), 
workstations, and cables in a network, while a logical 
topology defines the way in which the information flows 
between various components of a network. 

		�  Major network topologies are bus, star, ring, mesh, and tree 
topologies. 

		�  Bus Topology : In the bus topology, each computer and 
device of the network is connected to one main cable. This 
cable is known as the 'backbone'. In this type of network, 
one of the computers acts as a server. A server is a computer 
that processes the requests and delivers data to other 
computers. 

		�  Star Topology : In a star topology, each computer and device 
is connected to a central server, called a hub, through a 
point-to-point connection. The devices in the star topology 
can communicate with each other only through the hub. 

	 5.	� We need to secure a network against unauthorized access. 
In a computer network, multiple users access the same 
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data, and thus it becomes important to manage access to 
the network. For example, an unauthorized user can access 
the network of an organization and try to modify or steal 
confidential data. 

		�  Network security is ensured in many ways. Two of the most 
common ways are as follows: 
•• �Each authorized user is given a unique username and 

password for accessing the network. 
•• �Different users are given different types of access rights, 

such as read-only access, read-write access, and no access. 

2 	 Introduction to  
Microsoft Access 2016

A.	 Multiple Choice Question (MCQ) 

	 Darken the correct option in OMR Sheet :

	 1.	 (c)	 2. (d)	 3. (b)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 3	 3. 7	 4. 3	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 Tables 	 2. Title bar	 3. field	
	 4.	 Primary key 	 5. datasheet	
D.	 Write answers of the following :
	 1.	� Using a DBMS we can access and modify the data in a 

database, query the database to view a particular set of 
data, print the data in a pre-defined format and perform 
many other useful manipulations on the data. 

		�  In simple words we can say that Database Management 
System allows us to manage a database. The management 
of a database involves creating a database and modifying, 
deleting and adding data in it. 

	 2.	 (a) �Tables are the building blocks of a database. They store 
the complete data in a structured manner, i.e., in the 



47

form of rows and columns. Every table has a finite 
number of columns and rows. 

		  (b) �A database usually contains data pertaining to one 
particular entity or organization. 

		  (c) �A primary key is a field or combination of fields that 
uniquely identifies the records in a table. A primary key 
field cannot have repetitive values and cannot be left 
blank. In Table, Eno field can be made the primary key 
as every employee has a unique employee number. 

	 3.	 The steps to create a table in the Design view are : 
		  Step 1	:	 Click on the Create tab. 
		  Step 2	:	� Click on the Table Design option in the Tables 

group. A new table is inserted in the database and it 
opens in the Design View. A new tab named Design 
appears in the Ribbon. 

		  Step 3	:	� Enter the name for the field in the Field Name column. 
		  Step 4	:	� Choose a Data Type for a field from the Data Type list. 
		  Step 5	:	� Use the Field Properties pane to set the properties 

for the fields. 

				    Repeat steps 3 to 5 for all the fields in the table. 
		  Step 6	:	� Place the cursor on the field to be set as the Primary 

key and click on the Primary Key option in the Tools 
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group on the Design tab. You will notice that a key 
symbol appears next to the field. 

		  Step 7	:	� Click on the Save button on the Quick Access toolbar 
or click on the File tab and choose the Save option. 
Save the table with an appropriate name. 

	 4.	 Step 1	:	 Click on the column header that you want to move. 
		  Step 2	:	� Drag the header to the left or right. Release the 

mouse button after choosing the correct position. 

 
	 5.	 There are two views in a table- Design and Datasheet. 
		�  Design View : The Design view is used to design the structure 

of the database. The Design view window is divided into two 
parts. 
•• �Field Grid Pane: Field names and their description can be 

defined here. 
•• �Field Properties Pane: Properties for the fields can be 

defined here. 
		�  Datasheet View : Datasheet view displays a grid of rows and 

columns. The rows represent the records, and the columns 
represent the fields. The column headers are used to define 
the names of the fields. 

3 	 Working with Queries, 
Forms and Reports

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (c)	 2. (c)	 3. (d)	 4. (d)	
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B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 3	 3. 7	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Queries  	 2. Reports	 3. Relationship	
	 4.	 create 	 5. controls	
D.	 Write answers of the following :
	 1.	� A query is a method of getting answers to questions about 

data. The query can involve a single table or multiple tables 
to get the answer. 

	 2.	� A form provides an interface that allows users to enter, 
change, and view the data in a database tables. 

	 3.	 Follow these steps to create a form:  
		  Step 1	:	� Click on the table in the Navigation Pane on which 

the form should be based. 
		  Step 2	:	 Click on the Create tab. 
		  Step 3	:	� Click on the Form option in the Forms group. A 

form is created and it opens in the Layout View. You 
can change the view to the Form view and enter 
or display data in the table. Three new tabs Design, 
Arrange and Format appear in the Ribbon. 

		  Step 4	:	� Click on the Save option in the Quick Access Toolbar 
or the Save option on the File tab to save the form. 
You will notice that the Form object gets added to 
the Navigation Pane. 

	 4.	� Reports are used to present data from tables or queries 
in a format that can be printed. Printouts of report cards, 
invoices are examples of reports. We cannot make changes 
to the data in a report. 

	 5.	� Printing a Report : To print a report, select the File tab 
and then click either on the Print option or select the Print 
Preview View option. 

		�  This view displays how the report will appear on a page. It 
also allows us to choose the Page orientation, Page setup, etc. 
•• �If needed, modify the page size, margin width, and page 
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orientation using the related commands on the Ribbon. 
•• �Click on the Print option. The Print dialog box will appear. 

Set any desired print options then click OK. 

4 	 More on Photoshop

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (b)	 2. (c)	 3. (d)	 4. (d)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 7	 3. 3	 4. 3	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 black, white 	 2. pencil	 3. Paint Bucket Tools	
	 4.	 Clone Stamp 	 5. background	
D.	 Write answers of the following :
	 1.	� The Healing Brush Tool allows you to repair imperfections 

such as scratches, blemishes and marks in an image. While 
working with this tool, you pick up sample pixels (pixels 
to be used for repairing) from the adjoining portion of an 
image. The Healing Brush Tool matches the texture, lighting, 
transparency and shading of the sampled pixels and applies 
them to the pixels that are being repaired. 

		�  The Spot Healing Brush Tool works in a similar manner 
to the Healing Brush Tool except that it does not require 
the sampling point to be set. It automatically picks up the 
sampled pixels from around the area to be retouched. This 
tool can be used to quickly remove spots, blemishes and 
other marks from photographs. 

	 2.	� The Pattern Stamp Tool clones from a pre-defined area of 
pixels such as a pattern. You have to first define a pattern 
and then you can clone it. 

	 3.	 The steps to use the Type Tool are : 
		  Step 1	:	 Open the image. 
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		  Step 2	:	� Select the Horizontal Type Tool or the Vertical Type 
Tool. 

		  Step 3	:	� Set the appropriate 
options such as 
font family, size, 
style, alignment 
and text colour for 
the Type Tool in the Options bar. 

		  Step 4	:	� Click to set the insertion point anywhere on the 
image. 

		  Step 5	:	 Enter the desired text. 
		  Step 6	:	� Accept changes to the text by clicking the Commit 

button or cancel the operation by pressing the 
Cancel button in the Options bar. 

	 4.	� Layers can be thought of as transparent sheets mounted on 
the top of each other. 

		�  Layers let you work on an individual part or an element of 
an image without affecting the other parts or elements. You 
can change the composition of an image by changing the 
order and properties of layers. 

		�  Elements placed on higher layers are displayed above the 
elements placed on lower layers. 

5 	 Using Lists, Images and Links

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (a)	 2. (d)	 3. (c)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 7	 3. 7	 4. 3	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Type	 2. Numbered	 3. 1	
	 4.	 <dt> 	 5. <marquee>	
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D.	 Write answers of the following :
	 1.	 The types of list that HTML provides are : 

•• Unordered List 
•• Ordered List 
•• Definition List 

	 2.	� An unordered list is a collection of related items that have no 
special order or sequence. The list can be defined within the 
<ul> and </ul> tags. Each item in the list is marked with a bullet. 
That is why unordered list is also known as Bulleted List. 

		�  The ordered list is used to display the list of items in a 
specific order. The list begins and ends with <ol> and </
ol> tags respectively. Each item in the list is marked with a 
number, that is why it is also known as the Numbered List. 

	 3.	� We can use type attribute to specify the type of numbers 
we like. By default, its value is '1' for an ordered list. We 
can also use start attribute with an ordered list to specify 
the start value of the first item from which an ordered list 
should start. By default, ordered lists start at 1. 

	 4.	� Specifies the text to be displayed while the file loads or if 
the browser does not support graphics. 

	 5.	� A website consists of a number of web pages that give you 
access to the related information. HTML renders a powerful 
feature of linking these web pages together. This feature is 
called Hyperlinking. Using these hyperlinks, one can open 
any linked web page on the Internet instantly. When you 
hover the mouse pointer over a link, it changes into a little 
hand. 

		  Types of Linking 
•• Internal Linking •• External Linking 

		�  Internal linking: When one part of a web page is linked to 
another section on the same page, it is called internal linking. 

		�  External linking: When one page is linked to another web 
page or website, it is called external linking. 
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6 	 Tables in HTML

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (c)	 2. (a)	 3. (d)	 4. (c)	
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 7	 3. 7	 4. 7	 5. 7
C.	 Fill in the blanks using help box :
	 1.	 Tables	 2. <th>	 3. <caption>	
	 4.	 thicker 	 5. bgcolor	
D.	 Write answers of the following :
	 1.	 Tables are created to: 

•• Present Information or data in a comprehensive manner 
•• Make comparative analysis of data 
•• �Display information that is easier to read and quicker to 

evaluate 
	 2.	 The basic structure of a table consists of the following tags. 
		  1.	� <table> tag: The <table> and </table> tags mark the 

beginning and the end of a table in an HTML document. 
		  2.	� <tr> tag:  <tr> tag defines a row in the table. It is the <tr> 

tag that divides a table into rows. 
		  3.	� <th> tag: <th> tag defines a header cell in the table. 

The first row of the table can be divided into data cells 
using the <th> tag. The text enclosed within the <th> tag 
is aligned centrally inside the cell and is displayed in a 
bolder font. 

		  4.	� <td>tag: <td> tag defines a cell in the table. Subsequent 
rows after the first row in the table can be divided into 
data cells using the <td> tag. 

	 3.	� Cellpadding : This attribute sets the margins within a cell. It 
sets the amount of space in between the cell border and the 
cell data. The value of this attribute is indicated in pixels.
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		�  Example: <table border="3" bordercolor ="BLUE" 
bgcolor="White" align= "Center" cellpadding="10">

		  Cell Spacing 
		�  This attribute is used to set the minimum distance between 

two adjacent cells. CellSpacing is also measured in pixels. 
		�  Example: <table border="3" bordercolor ="BLUE" 

bgcolor="White" align= "Center" cellspacing="10">

	

4.

	

rowspan This attribute specifies 
the number of rows a 
data cell should span. This 
attribute is used with the 
<td> tag or the <th> tag. 

<td rowspan ="2">

colspan This attribute specifies 
the number of columns a 
data cell should span. This 
attribute is used with the 
<td> tag or the <th> tag. 

<td colspan="2"> 

   

7 	 Know More  About Python

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (d)	 2. (c)	 3. (a)	 4. (c)	 5. (d)	 6. (d)
B.	 �Tick (3) for true statement and cross (7) for false statement :

	 1.	 3	 2. 7	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 Website developer	2. parameter	 3. slice	
	 4.	 commas 	 5. Python string	 6. predefined
D.	 Write answers of the following :
	 1.	� Python is a multi-purpose programming language. We can 

use it for a variety of tasks. We can learn Python for machine 
learning and AI. In fact, Python is the best language for 
machine learning and data science projects. Python is also 
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popular for website development. Let us take the next step 
in learning the Python programming language.

	 2.	� Python function is a block of code which only runs when 
it is called. We can pass data, known as parameters, into a 
function. A function can return data as a result.

		�  There are many advantages of the Python functions. Let’s 
know about them.

		�  By using the functions, we can avoid the repeating of the 
same code block.

		�  Once the function has been defined, it can be called many 
times and from anywhere.

		  By using the function, program can be easily modularized.
		�  By using the function, we can return as many outputs as we 

want with different arguments.
		  Syntax:
		  def function_name (parameters):
		  # body of the function
		  return expression
		  Elements of Functions

•• �The beginning of a function header starts with the keyword 
‘def’ followed by the function name and parentheses.
•• �We pass arguments to the defined function using 

parameters.
•• The function header is terminated by a colon (:).

•• �The body of the function is made up of several valid 
Python statements. The indentation depth of the whole 
code block must be the same.
•• �We can use a return expression to return a value from a 

defined function.
	 3.	� Python tuple is another sequence data type that is similar 

to the list. A tuple consists of a number of values separated 
by commas. Unlike lists, however tuples are enclosed within 
parentheses. The main differences between lists and tuples 
are: Lists are enclosed in brackets ([ ]) and their elements 
and size can be changed, while tuples are enclosed in 
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parentheses ( ( ) ) and cannot be updated. Tuples can be 
thought of as read-only list.

		  Syntax:
		  Tuple_name = (item 1, item 2, item 3, - - - - - - - - -) 
	 4.	� Creating a Function : In Python, a function is created by 

using the ‘def’ keyword:
		  Example:
		  def welcome ():
		  print ("Welcome for using me")
	 5.	� Defining and Calling a Functions with Parameters : The 

parameter contains the types and names of the arguments 
that must be passed to the function.

		  Syntax:
		  def function_name(parameter: data_type):
		  #body of the function
		  return expression
		�  Program :  To calculate the addition of two numbers and 

print the result.

		

		  Output of the Program

		

	 6.	� Python string is the collection of the characters enclosed 
within quotes. Strings in python are surrounded by either 
single quotation marks or double quotation marks.
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		  ‘Hello’ is the same as "Hello".
		�  Subsets of the strings can be taken using the square brackets 

([ ] and [:]) with indexes starting at 0 in the beginning of the 
string and working their way from – 1 at the end. The plus 
(+) sign is the string concatenation operator and the asterisk 
(*) is the repetition operator.

		  Syntax:
		  Strng_name = “collection of characters”
		  Example:
		  str = ‘Welcome to use Python!’
		  print(str)	 # Prints complete string
		  print(str[0])	 # Prints first character of the string 

8 	 E-Governance and
 E-Commerce

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :

	 1.	 (d)	 2. (c)	 3. (c)	 4. (d)	 5. (c)	 6. (d)
B.	� Tick (3) for true statement and cross (7) for false statement :

	 1.	 7	 2. 3	 3. 3	 4. 7	 5. 3
C.	 Fill in the blanks using help box :
	 1.	 digilocker	 2. G2G	 3. E-Commerce	
	 4.	 Producers 	 5. Consumer-to-Consumer
	 6. Security	
D.	 Write answers of the following :
	 1.	  �E-governance, expands to electronic governance, is the 

integration of Information and Communication Technology 
(ICT) in all the processes, with the aim of enhancing 
government ability to address the needs of the general 
public. 

	 2.	� E-government functions can be classified into four main 
categories. 
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		  1.	� G2G (Government to Government): When the exchange 
of information and services is within the periphery of the 
government, is termed as G2G interaction. 

		  2.	 �G2C (Government to Citizen) : The interaction amidst 
the government and general public is G2C interaction. 

		  3.	 �G2B (Government to Business): In this case, the e- 
governance helps the business class to interact with the 
government seamlessly. 

		  4.	� G2E (Government to Employees): The government of any 
country is the biggest employer and so it also deals with 
employees on a regular basis, as other employers do. 

	 3.	� Commerce refers to the exchange of goods and services, 
usually for money. There are three parties to any such 
exchange: buyers, sellers, and producers. 

		  �Buyers are the people with money who want to purchase 
goods or services. 

		  �Sellers are the people who offer goods and services to 
buyers. Sellers are of two types retailers who sell directly 
to consumers and wholesalers or distributors who sell to 
retailers and other businesses. 

		  �Producers are the people who create the products and 
services that sellers offer to buyers. A producer is always, 
by necessity, a seller as well. He may sell the products to 
wholesalers, retailers, or directly to the consumer. 

	 4.	� Types of E-Commerce : There are four kinds of e-commerce 
models at present. These models are as follows: 

		�  Business-to-Business : This model involves transactions 
taking place between companies. 

		�  Business-to-Consumer : This model refers to transactions 
between a company and a customer. 

		�  Consumer-to-Consumer : This model refers to e-commerce 
between consumers or individuals. 

		�  Digital Middlemen : This model refers to the e-commerce 
model that provides information about products from many 
other companies. 
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	 5.	 Advantages of E-Commerce 
•• �E-commerce provides the sellers with a global reach. Now 

sellers and buyers can meet in the virtual world, without 
the hindrance of location. 
•• �Electronic commerce will substantially lower the 

transaction cost. This allows the companies to enjoy a 
much higher margin of profit. 

9 	 Artificial Intelligence 
and its Impact

A.	 Multiple Choice Question (MCQ) 
	 Darken the correct option in OMR Sheet :
	 1.	 (a)	 2. (c)	 3. (c)	 4. (b)	 5. (d)	 6. (c)
B.	� Tick (3) for true statement and cross (7) for false statement :
	 1.	 7	 2. 3	 3. 7	 4. 3	 5. 7	 6. 7
C.	 Fill in the blanks using help box :
	 1.	 learning, reasoning,  Self-correction	 2. machine	
	 3. AGI		  4. Deep Blue 	
	 5. preparing data		
	 6. speech recognition	
D.	 Write the full form of  :
	 1.	 NLP	 : National Language Processing
	 2.	 NLU	 : National Language Understanding
	 3.	 NLG	 : National Language Generation	
D.	 Write answers of the following :
	 1.	� Artificial Intelligence is an intelligence perceiving, 

synthesizing, and inferring information demonstrated by 
machines, as opposed to intelligence displayed by humans. 
AI human-machine interactions refer to the contact 
between humans and machines to fulfil a specific task or 
operation. In human-machine interactions, hardware and 
software play a vital role in communication. The machine 
itself is considered as hardware and the interface should be 
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user friendly. It will be built upon tangible and attentive user 
interface principles. Data can be accessed through software 
and stored on storage devices.

	 2.	� As we know artificial intelligence is all about making the 
machines do some complex tasks, which just don’t include 
mechanical activities, but those tasks too which require 
human intelligence. There are three major domains of 
artificial intelligence in which machines are being made 
artificially intelligent. 

		  1.	 Data (Data Science)
		  2.	 Computer Vision (CV)
		  3.	� Natural Language Processing (NLP). 
	 3.	� The difference between HI and AI are follows:

•• �Human intelligence is natural, while artificial intelligence 
is ‘artificial’, i.e., man-made.
•• �Human intelligence is capable of performing different 

tasks, i.e., humans can take decision anytime in any 
situation but AI can only perform for which they are 
designed and programmed by humans.
•• �Humans take decision on the base of their own knowledge 

and understandings whereas artificial intelligence uses 
data and models which copies human command while 
making a decision.
•• �Humans have emotions and feelings while AI doesn’t have.

	 4.	 (a) �Computer vision is a field of artificial intelligence that 
enables computers and systems to derive meaningful 
information for digital images, videos and other visual 
inputs and to take actions or make recommendations 
based on it. Computer vision helps computers identify, 
process and interpret visual data. It uses the pattern 
identification to interpret the content of an image; also 
identifies the tables, graphs and images, PDF documents 
along with text and videos. Some applications of 
computer vision have already been used in industries 
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like healthcare, research and development, surveillance 
and smart cars.

		  (b) �It is the most basic variety of AI. It cannot make decisions 
based on the past scenarios or experiences. As the name 
suggests, reactive machines are purely reactive; they 
replicate a human’s ability to react to different kinds of 
stimuli. They lack the ability to use previously-acquired 
information to take better decisions.

			�   IBM’s chess-playing computer, Deep Blue is an example 
of reactive machine which is famous for defeating World 
Chess Champion, Gary Kasparov. It could identify different 
pieces of chessboard and all the possible legal moves 
for itself and the opponent. Based on the move of the 
opponent, it could select its best-possible move. However, 
it did not have ability to learn from its previous moves.

		  (c) �In psychology “Theory of Mind” that people have 
thoughts, feelings and emotions that affect their 
behavious. Future AI system must learn to understand 
that everyone (both people and AI objects) have 
thoughts and feelings. Future AI systems must know 
how to adjust their behaviour to be able to walk among 
us. As the name suggests basically it is the type of AI, 
which can understand or learn the human emotions 
and their beliefs. As of now, researchers are still in the 
process of developing ‘Theory of Mind’ machines.

		  (d) �These types of AI are slightly advanced in the comparison 
of the first one. In addition to all the characteristics 
of reactive machines, they have memory capabilities 
and can use past scenarios and experiences to take 
better future decisions. Machines, which fall under this 
category, can be trained by using data and information. 
Most of the common applications of AI which we see 
around us are based on limited memory technology.

			�   Self-driving vehicles, virtual assistants and chatbots are 
some of the examples of limited memory technology.
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	 5.	 �Natural Language Processing (NLP): Natural Language 
Processing (NLP) is a field of AI that combines computer 
science, linguistics, and machine learning to study how 
computers and humans communicate in natural language. 
The goal of NLP is for computers to make them able 
to interpret and generate human language. It not only 
improves the efficiency of work done by humans but also 
helps in interacting with the machine. NLP bridges the gap 
of interaction between humans and electronic devices.

		  Natural language processing field is divided into three parts:
		�  Speech Recognition: It is used for translation of spoken 

language into Artificial language text.
		�  Natural language Understanding (NLU): It is used for spoken 

or written language to provide a link between natural 
language inputs and what they present. It analysis different 
aspects of language.

		�  Natural Language Generation (NLG): It helps to produce 
meaningful phrases and sentences along with Text planning, 
sentence planning, and Text realization.
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